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Operator help

There are Operator help tasks you can perform to ensure IBM® Sterling File
Gateway performs according to your business needs.

System status

Viewing file activity
You can view activity status information for the last hour, day, and week.

Procedure
1. From the main menu, select Tools > Activity Snapshot.
2. A new window opens. While this window is open, you cannot perform other

actions in Sterling File Gateway. Clicking on any of the numbers on the screen
opens the Arrived File search results page.

Note: The system will not time out while the Activity Snapshot is running. You
should not leave it unattended.
Metrics for the following activities are displayed for the last day, hour, or week:
v Total Arrived Files - Arrived Files are the files that arrive from a producer.

This is the total number of arrived files that completed in the specified time
period. These are Producer files. For example, a Zip file containing 532 files
only counts as one file. Click on this number to display a list of this set of
arrived files. If new activity occurs between the snapshot display and the
click, the list includes the new arrived files.

v Total Payloads - Payloads are either the arrived files (if non-container type)
or files found inside a container type. This is the number of payloads found
within completed arrived files. Click on this number to display a list of this
set of arrived files they originated from.

v Unidentified Files - This is the number of arrived files that failed because
no routing channel could be identified for any of their payloads.

v Successfully Routed - This is the number of payloads that were successfully
routed. Click on this number to display a list of arrived files they originated
from.

v New Failures - This is the number of payloads that failed to route for any
reason other than total route identification failure. Excludes reviewed
failures. Click on this number to display a list of arrived files they originated
from.

v Reviewed Failures - This is the number of payloads that failed to route for
any reason other than total route identification failure. Includes only
reviewed failures. Click on this number to display a list of arrived files they
originated from.

3. Click on Total in-flight to see a list of files currently being processed. These are
arrived producer files that have not yet moved to a completed state.

4. Click on an item in the returned list to request the details about a route.
5. To view details, close the Activity Snapshot window.
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Searching for a file
You can search for files in your mailbox by using parameters in the Basic Search
and Advanced Search pages.

About this task

You can specify more criteria to narrow your results, or fewer criteria to widen
your results. For any field, leave blank to select all values.

To search for a file:

Procedure
1. On the Search Criteria tab, enter the basic search parameters. The Basic Search

page is useful to find files in major categories. To search for more-specific
files, use the Advanced Search page. The Basic Search parameters are also
available on the Advanced Search page, along with more parameters.

2. (V2.2.6 or later) Select the appropriate Mailbox Type. You can search for a file
in the distributed mailbox, a traditional mailbox, or both, . A distributed
mailbox is available in the Global Mailbox realm.

3. Select the Producer from the list or type the producer name. Leave this field
blank to search for files from all producers.

4. Select the Consumer from the list or type the consumer name. Leave this field
blank to search for files from all consumers.

5. (V2.2.6 or later) Type the Original File Name to search for a file that is based
on the name of the file that is created by the producer.

6. Select the appropriate Status. The available options are as follows:
v

Started
Includes files for which routing is started, files for which Sterling
File Gateway is determining routes, files for which routing is
pending, and files, which are being routed

v

Succeeded
Includes routed files (arrived files, routes, and deliveries)

v

Failed Includes failed files
v

(V2.2.6 or later) Ignored
Includes ignored files

Leave blank to search for files with any status.
7. Select the Protocol used by the producer to submit the message. The available

options are as follows:
v FTP

v SFTP

v Connect:Direct

v (V2.2.6 or later) WMQFTE

v (V2.2.6 or later) EBICS
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Important: The Protocol option is enabled only if you select Traditional
mailboxes only for Mailbox Type.

Restriction: When distributed mailboxes are searched, only mailboxes on the
local node are searched. Messages in distributed mailboxes in other data
centers are not searched.

8. (V2.2.0 - 2.2.5) For Original File Name, type the full or partial name of the file
the producer sent. This field is case-insensitive. File names containing the
string will be matched in the search. Leave this field blank to search for all file
names.

9. (V2.2.6 or later) Specify appropriate time and date values.
10. Click Find to initiate the search. The Search Results tab opens and the Arrived

File pane is displayed with results that match the criteria that you specified. A
maximum of 1000 files (or another limit set by your system administrator) is
displayed. The following information is provided for each arrived file:
v Reviewed
v Status
v Producer
v (V2.2.0 - 2.2.5) File Name
v (V2.2.6 or later) Original file name
v Discovery Time
If more than 1000 files (or another limit set by your system administrator)
match your criteria, a message is displayed indicating that you have more
than 1000 matches and need to narrow your search. The first 1000 files are
displayed.

11. Sort the results by clicking any column header. Click again to change from
descending order to ascending order. The default sort is Discovery Time, in
descending order.

12. To search for a file with more specific criteria, click Advanced Search.
13. Select appropriate parameters in the Arrived File section:

Mailbox Type
Select from the following values:
v Traditional mailboxes only - the traditional Sterling B2B Integrator

mailbox
v Distributed mailboxes only - available in the Global Mailbox realm
v Both traditional and distributed mailboxes

Producer
The partner who creates and sends files. Select from the list. Type the
producer name to obtain unpurged data for producers who are
deleted. Leave blank to search for files from all producers.

Producer Code
The code for the producer. Select from the list. Type the producer code
to obtain unpurged data for producers who are deleted. Leave blank
to search for files from all producers.

Producer Group 
The group the producer is a member of. Select from the list. Type the
producer group to obtain unpurged data for groups that are deleted.
Leave blank to search for files from all groups.
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(V2.2.0 - 2.2.5) IP Address
The host IP address of the producer.

User User ID of the protocol authentication.

(V2.2.6 or later) For WebSphere® MQ File Transfer Edition, the user ID
is the MQMD User ID that is associated with the transfer.

((V2.2.6 or later) The User field is disabled if you select one of the
following options for Mailbox Type list or leave it blank:
v Distributed mailboxes only

v Both traditional and distributed mailboxes

Protocol

Select from:
v FTP

v SFTP

v Connect:Direct

v (V2.2.6 or later) WMQFTE

v (V2.2.6 or later) EBICS

(V2.2.6 or later) The Protocol option is disabled if you select one of
the following options for Mailbox Type list or leave it blank:
v Distributed mailboxes only

v Both traditional and distributed mailboxes

Original File Name
Full or partial name of the file the producer sent. This field is
case-insensitive.

File Size (Min) (kilobytes)
Smallest file size to search for.

File Size (Max) (kilobytes)
Largest file size to search for.

Status Select the appropriate status:
v Started - includes Started, Determining Routes, Pending, and

Routing
v Succeeded - includes Routed (arrived files, routes, and deliveries)
v Failed - includes Failed
v (V2.2.6 or later) Ignored - includes Ignored

Reviewed
Select the required option:
v Show both reviewed and unreviewed arrived files

v Show only unreviewed arrived files

v Show only reviewed arrived files

Tip: Use these options to manage your review process of file
transfers.

(V2.2.0 - 2.2.5) Message ID
The unique message ID of the arrived file.

(V2.2.6 or later) Mailbox Message ID
The unique message ID of the arrived file.
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Mailbox Path
Full or partial name for the mailbox directory path of the arrived file.
This field is case-insensitive.

Dataflow ID
The numeric dataflow ID for the file.

(V2.2.6 or later) The Dataflow ID field is disabled if you select one of
the following options for Mailbox Type list or leave it blank:
v Distributed mailboxes only

v Both traditional and distributed mailboxes

Date (From)
Click the calendar icon to select the date to begin the search.

Date (To) 
Click the calendar icon to select the date to end the search.

Time (From)
The arrival hour, in 24-hour format, to begin the search. If the date
fields remain blank, the time fields are ignored. If 0 is entered, record
for all times are returned.

Time (To)
The arrival hour, in 24-hour format, to end the search. If the date
fields remain blank, the time fields are ignored. If 0 is entered, record
for all times are returned.

14. Select appropriate parameters in the Route section:

Consumer
The partner who receives files directly or in a mailbox. Select from the
list. Type the consumer name to obtain unpurged data for consumers
who are deleted. Leave blank to search for files from all consumers.

Consumer Code
The code for the consumer. Select from the list. Type the consumer
code to obtain unpurged data for consumers who are deleted. Leave
blank to search for files from all consumers.

Consumer Group
The group the consumer is a member of. Select from the list. Type the
consumer group to obtain unpurged data for groups that are deleted.
Leave blank to search for files from all groups.

Template Name
Routing Channel Template applied to the file transfer. Finds files that
successfully routed based on the template.

Facts Select from:
v ConsumerCode

v ConsumerFilename

v ConsumerName

v ConsumerPgpExtension

v ProducerCode

v ProducerFilename

v ProducerName

Tip: The list also includes any custom facts that are defined by the
Integration Architect, with a prefix of "my".
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Fact Value
Value for the previously selected fact. Required when Facts is selected.
This field is case-insensitive.

Status Select the appropriate status:
v Started - includes Started, Determining Routes, Pending, and

Routing
v Succeeded - includes Routed (arrived files, routes, and deliveries)
v Failed - includes Failed

15. Select appropriate parameters in the Delivery section:

(V2.2.0 - 2.2.5) IP Address
Host IP address for the delivered file. Do not use with In Mailbox
specified as the protocol.

User User ID of the protocol authentication. Do not use with In Mailbox
specified as the protocol.

(V2.2.6 or later) The User field is disabled if you select one of the
following options for Mailbox Type list or leave it blank:
v Distributed mailboxes only

v Both traditional and distributed mailboxes

Protocol
Delivered file protocol. Select from:
v FTP

v Inbound FTP

v Outbound FTP

v SFTP

v Inbound SFTP

v Outbound SFTP

v Connect:Direct

v Inbound Connect:Direct

v Outbound Connect:Direct

v (V2.2.6 or later) WMQFTE

v In Mailbox (for files that are not retrieved)

v (V2.2.6 or later) EBICS

(V2.2.6 or later) The Protocol option is disabled if you select one of
the following options for Mailbox Type list or leave it blank:
v Distributed mailboxes only

v Both traditional and distributed mailboxes

Delivered File Status
Select the appropriate status:
v Started - includes Transforming, Delivering, and Redelivery
v Succeeded - includes Complete
v Failed - includes Failed

Delivered File Name
Full or partial name of the delivered file. This field is case-insensitive.

File Size (Min) (kilobytes) 
Smallest file size to search for.
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(V2.2.6 or later) The File Size (Min) field is disabled if you select one
of the following options for Mailbox Type list or leave it blank:
v Distributed mailboxes only

v Both traditional and distributed mailboxes

File Size (Max) (kilobytes) 
Largest file size to search for.

(V2.2.6 or later) The File Size (Max) field is disabled if you select one
of the following options for Mailbox Type list or leave it blank:
v Distributed mailboxes only

v Both traditional and distributed mailboxes

(V2.2.0 - 2.2.5) Message ID
The unique message ID of the delivered file.

(V2.2.6 or later) Mailbox Message ID
The unique message ID of the delivered file.

Mailbox Path
Full or partial name for the mailbox directory path of the delivered
file. This field is case-insensitive.

Date (From)
Click the calendar icon to select the date to begin the search.

Date (To)
Click the calendar icon to select the date to end the search.

Time (From)
The delivery hour, in 24-hour format, to begin the search. If the date
fields remain blank, the time fields are ignored. If 0 is entered, records
for all times are returned.

Time (To)
The delivery hour, in 24-hour format, to end the search. If the date
fields remain blank, the time fields are ignored. If 0 is entered, records
for all times are returned.

Restriction: Searches using the characters _ and % (underscore and percent)
might produce more results than expected, because these characters are
interpreted as wild cards. Specify more characters to narrow your search, or
visually search for the matches within the returned results.

Results

Search results

In the search results for arrived files, the producer name is listed, if available. If
producer name is not available, the producer code is listed in italics.

In the search results for routes, the consumer name is listed, if available. If
consumer name is not available, the consumer code is listed in italics.

Viewing route information
The Search Results tab provides the Arrived Files that meet the criteria specified
for your search.
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About this task

To view the detailed route information:

Procedure
1. Sort the results by clicking on the header of any column. Click again to change

from ascending to descending order.
2. Under Arrived Files, click in the row of the file you are interested in. Arrived

file events are displayed in the right pane, with the time and description. Select
the hyperlinks within the description to view more information about any
event. Error events are displayed in red.

3. Click in the row of an event you are interested in to get details about the event.
4. To view routing channel template details, select the routing channel, right-click,

select View associated template.

Note: If the template has been edited or deleted after the route executed, the
details are no longer available. A message is displayed:
The instance of the template you are trying to view is no longer available.

5. Sort the results by clicking on the header of any column. Click again to change
from ascending to descending order.

Marking activity as reviewed
On the search results page, Operators can use the reviewed checkbox to track
when arrived files are reviewed.

About this task

To mark activity as reviewed:

Procedure
1. On the Search Results page for Arrived Files, right-click in the reviewed

checkbox on the row of the file you want to mark as reviewed and select Mark
as reviewed. Shift-click to select multiple files to mark at once.

2. To remove the reviewed check mark, right-click again and select Mark as not
reviewed.

Activity history for deleted objects
After a partner, group, routing channel, or routing channel template is deleted, you
can still access the history of the activities, if the activity has not been purged.

To view the history, type the value for the deleted object in the appropriate search
field and click Find. Results displayed include activity for the deleted partner.

Generating reports
You can generate reports to get lists of transactions that match the criteria you
specify. From the reports, you can learn the number and size of file transfers by
producer or consumer, and the number of failed, successful, and in progress
transfers.

About this task

To generate reports:

8 Sterling File Gateway: Operator



Procedure
1. From the main menu, select Tools > Reports.
2. Select the information you would like the report to contain. Leave any field

blank to select all possible values. Options are:

Mailbox Type (V2.2.6 or later)
Select from the following values:
v Traditional mailboxes only - the traditional Sterling B2B Integrator

mailbox
v Distributed mailboxes only - available in the Global Mailbox realm
v Both traditional and distributed mailboxes

Restriction: When you select distributed mailboxes that exist in
multiple data centers, the report displays only data of the local data
center where the report is generated.

Producer
Select a producer for the arrived files to report on. Do not use if
Producer Group is specified.

Producer Group
Select a producer group for the arrived files to report on. Do not use if
Producer is specified.

Consumer
Select a consumer for the arrived files to report on. Do not use if
Consumer Group is specified.

Consumer Group
Select a consumer group for the arrived files to report on. Do not use if
Consumer is specified.

Status Select one or more from:
v Started - includes Started, Determining Delivery, and Delivering
v Succeeded - includes Complete
v Failed - includes Failed
v Ignored - includes Ignored

Date (From)
Click on the calendar icon to select a starting date.

Date (To)
Click on the calendar icon to select an ending date.

Time (From)
Specify a time in the format hh:mm:ss.

Remember: Query in server time. Report results are in server time,
regardless of the header label.

Time (To)
Specify a time in the format hh:mm:ss.

Remember: Query in server time. Report results are in server time,
regardless of the header label.

Group By
Select from:
v Producer
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v Consumer

Format
Select from:
v HTML
v PDF
v XLS

Report Type
Select from:
v Detailed - includes a Producer ID (assigned by the system),

Consumer, Discovery Time, Completion Time, Status, Original File
Name, and File Size

v Summary - includes Total File Size and Total Count by Success, Error,
In Progress, and Failure Reviewed

Tip: Error count is the number in Failed status that have not been
reviewed.

Sort By
Click and drag the following fields into the desired order for sorting:
v Status
v File Name
v File Size

3. Select Generate Report.

Restriction: For reports with Asian characters, download and install the special
Acrobat Reader Asian font packs from www.adobe.com. Text for reports is
generated with iText using CJK fonts. If the Asian font packs are not installed,
Acrobat Reader might ask you to install when you open a PDF file containing
CJK fonts.
Depending on your selections, the report has the following contents:

Created On
Date and time report was requested

Created By
User ID that requested the report

Group By
How the data is grouped

Report Config
Selections made for report

Filters How the data is ordered

Producer ID
ID assigned by the system for the producer that created and sent the
file

Consumer
Partner that received the file. The Consumer Name is listed, if available. If
Consumer Name is not available, the Consumer Code is listed, delineated
by <>.

Discovery Time
Time file first entered system, in the server time zone, regardless of the
header label
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Completion Time
Time file transfer was completed, in the server time zone, regardless of
the header label

Status Status when report was generated

Original File Name
Name given to the file by the producer

File Size
Size of the transferred file

Summary

v Producer
v Total File Size
v Total Count
v Success
v Error
v In Progress
v Failure Reviewed

For each producer, the total file size transferred in the report period,
total count of files transferred in the report period, and a count for each
status category. The Producer Name is listed, if available. If Producer
Name is not available, the Producer Code is listed, delineated by <>.

Tip: Error count is the number in Failed status that have not been
reviewed.

Restriction: By default, reports only include the first 1000 activity records that
match the specified criteria. Your System Administrator may set another value
for the number of records to be included in reports. (See System Administrator
Install and Set Up filegateway_ui.properties.)

Tip: Sterling File Gateway users with Microsoft Internet Explorer 7 may not be
able to open more than one PDF type report at a time due to Internet Explorer
7 content blocking security. Close the original report window or adjust Internet
Explorer 7 browser setting or configure Adobe Reader to not open in a browser
(and instead open in an Adobe window).

In Internet Explorer 7, select Internet Options > Security (tab) > Custom level
> Downloads > Automatic prompting for file downloads > Enabled.

In Adobe Reader, select Preferences > Display PDF in browser > disabled.

About event codes
Each activity during the progress of a file transfer generates an event code. These
codes are displayed in the activity details to enable Partners and Operators to see
the progress and navigate to more details. System Administrators can create
custom event codes and modify the permissions for standard event codes.

Some event codes trigger notifications to subscribers. System Administrators can
change the permissions for an event code by using the
customer_overrides.properties file to override values in the
filegateway_eventcodes.properties file. The default subscription settings are
provided in the table below:
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Event Code Name Description
Default Subscription
Settings

FG_0050 MailboxAuthorizationFailure When a user fails to access
a mailbox that is monitored

Operators

FG_0201 BusinessProcessStarting When a business process is
started, with the reason for
starting it stored in context.

Only in activity details.

FG_0202 BusinessProcessSuccess When a business process is
successfully completed,
with a link to the business
process.

Only in activity details.

FG_0203 SendMessageBusinessProcessStarted When a business process is
successfully started, with a
link to the business process.

Only in activity details.

FG_0250 BusinessProcessFailure When a business process
fails, with a link to the
business process

Operators

FG_0401 FactDiscovery When a fact is discovered
by the route, for example,
matching a pattern on the
file name.

Only in activity details.

FG_0404 ProducerFound When a producer and user
are identified based on the
arrived file.

Only in activity details.

FG_0407 ConsumerFound When a consumer is
identified based on the
route plan.

Only in activity details.

FG_0408 ArrivedFileStarted When a file arrives to be
routed

Operators, producers, and
consumers

FG_0409 ArrivedFileDeterminingRoutes When an arrived file starts
determining routes.

Only in activity details.

FG_0410 ArrivedFileRouting When an arrived file starts
processing routes.

Only in activity details.

FG_0411 ArrivedFileRouted When an arrived file
completes all its routes

Operators, producers, and
consumers

FG_0412 RouteStarted When a route is started
from an arrived file.

Only in activity details.

FG_0413 RouteDeterminingDeliveries When a route starts
determining deliveries.

Only in activity details.

FG_0414 RouteDelivering When a route starts
processing deliveries.

Only in activity details.

FG_0415 RouteComplete When a route completes all
its deliveries

Operators, producers, and
consumers

FG_0416 DeliveryStarted When a delivery is started
from a route.

Only in activity details.

FG_0417 DeliveryTransforming When a delivery starts to
transform the consumer
file.

Only in activity details.

FG_0418 DeliveryDelivering When a delivery starts
delivering the consumer file
to the consumer.

Only in activity details.
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Event Code Name Description
Default Subscription
Settings

FG_0419 DeliveryComplete When a delivery is
complete

Operators, producers, and
consumers

FG_0420 ArrivedFileReplayed When an arrived file is
replayed, with a link to the
replay

Operators, producers, and
consumers

FG_0421 ArrivedFileReplayOf When an arrived file is a
replay of an original
arrived file, with a link to
the original file.

Only in activity details.

FG_0422 Redeliver When a redelivery is
requested by a user

Operators, producers, and
consumers

FG_0423 DeliverRedelivering When a delivery starts
redelivering the consumer
file to the consumer.

Only in activity details.

FG_0424 ArrivedFileIgnored When an arrived file is
ignored due to a configured
pattern for ignoring files

Operators, producers

FG_0425 ArrivedFileDescription The description of the
Arrived File

Operators, producers

FG_0426 DeliveryPending When a user manually
changes the state of a
delivery.

Operators, producers, and
consumers

FG_427 ManualStateChange When a producer message
is invalid or cannot be
found

Operators, producers

FG_0450 ProducerMessageNotFound When a producer message
is invalid or cannot be
found

Operators, producers

FG_0451 ProducerDocumentNotFound When a producer document
is invalid or cannot be
found

Operators, producers

FG_0455 ArrivedFileFailed When an arrived file fails Operators, producers

FG_0456 RouteFailed When a route file fails Operators, producers, and
consumers

FG_0457 DeliveryFailed When a delivery fails Operators, producers, and
consumers

FG_0458 FileGatewayServiceVersionMismatch When a newer version of a
system business process is
installed, but is not the
default chosen version.

Operators

FG_0501 ProducerMailboxRouteCandidatesFoundWhen route candidates are
found for an arrived file
based on the producer and
the mailbox of the message.

Only in activity details.

FG_0502 RouteCandidatesFound When route plan
candidates are found for an
arrived file.

Only in activity details.

FG_0503 RouteCandidate A route plan candidate for
an arrived file.

Only in activity details.
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Event Code Name Description
Default Subscription
Settings

FG_0504 Route When one or more routes
are chosen from the
candidates.

Only in activity details.

FG_0505 RoutesFound The number of routes that
will be executed.

Only in activity details.

FG_0506 Route Candidate Does Not Match When a routing channel
template contains no
matching producer file
structure for an arrived file.

Only in activity details.

FG_0550 ZeroRouteCandidatesFound When no route candidates
are found for an arrived file

Operators, producers

FG_0551 ZeroRouteChannelsFound When no route channels are
chosen from the list of
candidates for an arrived
file

Operators, producers

FG_0552 InvalidRoute When a route is invalid Operators, producers

FG_0553 InvalidConsumerBroadcastGroup When value of
ConsumerBroadcastGroup
does not contain name of
an existing partner group

Operators, producers

FG_0554 MaxBroadcastGroupSizeExceeded When the number of
consumers in broadcast
scenarios is too big

Operators, producers

FG_0601 TransformedMessage When a message is
transformed to the final
format for the consumer.

Only in activity details.

FG_0602 ProducerPayloadExtracting When the router begins to
extract a producer payload
file.

Only in activity details.

FG_0603 ConsumerPayloadConstructing When the router begins to
construct a consumer
payload file for delivery.

Only in activity details.

FG_0604 ConstructedLayer When a single layer in the
consumer payload file gets
constructed.

Only in activity details.

FG_0605 ExtractedLayer When a single layer in the
producer payload file gets
extracted.

Only in activity details.

FG_0606 LayerOptions When options are passed to
a business process to
process a layer.

Only in activity details.

FG_0607 PGPConstructSkipped When the PGP Construct
layer is skipped because
the consumer does not
handle PGP and it is
optional on the Routing
Channel Template

Operators, consumers

FG_0650 ExtractLayerFailed When extraction of a layer
fails

Operators, producers

FG_0651 ConstructLayerFailed When construction of a
layer fails

Operators, consumers
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Event Code Name Description
Default Subscription
Settings

FG_0701 DeliveredMailboxMessage When a message is
delivered to a mailbox
(either a consumer mailbox
or a mailbox for sending to
a listening consumer).

Only in activity details.

FG_0702 DeliveredListeningPartnerMessage When the file transfer is
complete.

Only in activity details.

FG_0703 ChangeDirectory When the supported
protocol changes directory
on the listening consumer's
server to transfer the file.

Only in activity details.

FG_0704 ConsumerDestinationMailboxFound When the destination
mailbox for the consumer is
discovered.

Only in activity details.

FG_0705 AsyncTransferIdAssigned When an additional
transfer identifier has been
associated with a delivery.

Operators, producers, and
consumers

FG_0706 AsyncTransferSuccessful When an asynchronous
transfer has reported
successful completion.

Operators, producers, and
consumers

FG_0707 AsyncTransferRequestAcknowledged When an asynchronous
transfer request has been
acknowledged as received.

Operators, producers, and
consumers

FG_0710 DeliveredDistributedMailboxMessage When a message is
delivered to a distributed
mailbox

Operators, producers, and
consumers

FG_0750 AmbiguousDeliveryRequestStatus When the submission status
of an asynchronous
delivery request is in
doubt.

Operators

FG_0751 DeliveryAlreadyInTerminalState When delivery status
notification is received for a
delivery already in a
terminal state.

Operators

FG_0752 AsyncTransferFailed When an asynchronous
transfer has reported
failure.

Operators, producers, and
consumers

filegateway_eventcodes.properties
The filegateway_eventcodes.properties file contains properties that control the
operation of event codes in Sterling File Gateway.

There are multiple properties in the filegateway_eventcodes.properties file for
each event, in the format:
FG_<EVENT_CATEGORY><EVENT_CODE>.<PROPERTY_NAME>=<REPLACEABLE_TEXT>

where:
v <PROPERTY_NAME>is the parameter being defined for the particular event
v <REPLACEABLE_TEXT> is the value of the parameter for the particular event
v and the values used by Sterling File Gateway for <EVENT_CODE> and

<EVENT_CATEGORY> are:
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Event Code Event Category

00 Producer File Transfer

02 Routing Business Process

04 File Gateway General

05 Route Plan Determination

06 File Transformation

07 Consumer File Transfer

<EVENT_CODE> is a unique code (within the category) to identify this event.
Check the other properties (or the FileGatewayEvent enumeration) to ensure no
duplication.

<REPLACEABLE_TEXT> is text that displayed in the route details so users can
monitor progress of the route.

The following information is provided for each event:

Property Description Example

Name (V2.2.0 - 2.2.5) Name of the event. Displayed in the
subscription UI (Profile >
Notifications). Required.

XX_0050.name=MyCustomEventFailure

Name (V2.2.6 or later) Name of the event. Required. No
space.

XX_0050.name=MyCustomEventFailure

DisplayName (V2.2.6 or
later)

Displayed in the subscription UI
(Profile > Notifications).

XX_0050.displayName=MyCustomEventFailure

Attributes Comma delimited list of named
attributes to the event. Used in the
text field and must correspond to the
order listed in the text field. For
example, UserId attribute
corresponds to {0} below. All
attributes need not appear in the text
field. Required, but can be empty.

XX_0050.attributes=UserId,ErrorMessage

Text Event description displayed in the
route activity UI for a specific
occurrence of this event. Required.

XX_0050.text=User {0} encountered failure {1}

Description A generic event description that does
not use attributes. Displayed in the
subscription UI (Profile >
Notifications). Required.

XX_0050.description=When a user encounters this
custom event failure

Permissions Comma delimited list that indicates
who can be notified and who can
view this event. Possible values are:

v subscription - available for
subscription to notifications

v producer - producers can see in
events list and receive notifications

v consumer - consumers can see in
events list and receive notifications

Optional.

XX_0050.permissions=subscription
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filegateway_eventcodes.properties includes only standard events shipped with
Sterling File Gateway. Custom events you create are entered and configured in
customer_overrides.properties.

Note: Do not edit the filegateway_eventcodes.properties file. Make all changes
in the customer_overrides.properties file. For example, to change the name
property, enter the following line into customer_overrides.properties:
filegateway_eventcodes.name=CUSTOM

substituting CUSTOM with the name of your event code. See Add Custom Event
Codes.

Subscribing to notifications
Subscribe to notifications to receive email about Sterling File Gateway activity.

About this task

You can subscribe to certain events in Sterling File Gateway. When you subscribe
to an event, a notification is sent in an email to you whenever that event occurs, if
you have permission on the event. Event permissions are managed by the System
Administrator. Your user account must be configured with a valid email address to
receive notifications. To subscribe to events:

Procedure
1. From the main menu, select Profile.
2. Select the Notifications tab.
3. Drag an event from the left pane to the right pane to enable notifications.

Results

When an event that has been subscribed to occurs, an email notification is sent to
the email address in your user account.

Unsubscribing to notifications
If you no longer want to be notified of events in Sterling File Gateway, you can
unsubscribe.

About this task

To cancel notification of events:

Procedure
1. From the main menu, select Profile.
2. Select the Notifications tab.
3. Click Delete to disable notification for that event.

Setting up and viewing logs
To troubleshoot problems with file transfers that cannot be analyzed using the
Sterling File Gateway user interface, view the activity log. Only Operators and
System Administrators can edit log settings and view logs.
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About this task

New log files are created at midnight each day. If the maximum log file size is
exceeded during the same day, additional log files are created. Old logs are
automatically deleted after the pre-determined maximum number of logs is
reached. The default maximum number is ten, which can be changed in the
customer_overrides.properties file (logService.filegatewaylogger.maxnumlogs=10)

To set up logging:

Procedure
1. From the main menu, select Tools > Logs.
2. Scroll down to locate File Gateway.
3. Click on the edit icon next to File Gateway.
4. Select Logging Level On.

Note: Logging can affect performance, so should only be turned on while
troubleshooting problems.

5. Click Save.
6. View the log at Tools > Logs > File Gateway.

Replaying routes

Replaying a File Transaction from the Beginning (2.2.0 -
2.2.4.2)

Replay a successful or a failed route to have the file transferred again from the
beginning.

About this task

To replay a route:

Procedure
1. From the Search page, enter criteria for the file to replay.
2. Click Find to initiate the search.
3. On the Search Results page, right-click next to the file you want to replay.

Note: Once activity is purged, it is no longer available in the system and will
not be found in a search that matches the criteria for it. You cannot replay
messages that have been purged.

4. You can enter a new name to rename the file for the replay. Do not use the
following characters: !%*?<>"/\|:.

5. You can add a comment about the replay. Up to 255 characters are allowed for
the comment. The selected file is replayed and added to the list of arrived files,
with a special icon to indicate it is a replay. You can replay a route any number
of times.

6. When you replay a route, the reviewed box is automatically checked.
Right-click and select Mark as not reviewed to remove the check.
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Replaying files (V2.2.5 or later)
Replay successful or failed routes to have one or more files transferred again from
the beginning. When a file is replayed, all the route processing is repeated. You can
select files to replay, or replay all files in the list.

About this task

Restriction: Requires Sterling File Gateway Version 2.2.5 or later.

To replay a route:

Procedure
1. Use either Basic Search or Advanced Search. From the Search Criteria tab, enter

the criteria for the file or files you want to replay.
2. Click Find to initiate the search.

Remember: After activity is purged, it is no longer available in the system and
is not found in a search that matches the criteria for it. You cannot replay
messages that are purged.

3. To replay all files matching the search criteria:
a. Click Replay All.
b. In the Replay Arrived File pop-up, you can add a comment about the

replay. Up to 255 characters are allowed.
c. Click Replay.

All files matching the search criteria, not just the ones displayed or selected, are
replayed.
Skip the remaining steps.

4. To replay only selected files, on the Arrived File tab, select one or more files to
replay.
v To select a file, click the check box in the first column to display a check

mark.
v To select all files, click the Header check box at the top of the column. All

selected files display a check mark in the first column.
The Header check box displays one of the following values depending on file
selections:

Checked
All the files are selected

Unchecked
No files are selected

Filled Some, but not all, of the files are selected
If only one file is selected, the Arrived File Events will be displayed and Route
and Delivery tabs will be available.

5. Click Replay. In the Replay Arrived File pop-up:
a. If only one file was selected, you can enter a new name to rename the file

for the replay. Do not use the following characters: !%*?<>"/\|:..
b. You can add a comment about the replay. Up to 255 characters are allowed.
c. Click Replay.
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Results

The selected files are replayed and added to the list of arrived files, with a special
icon to indicate it is a replay.

(V2.2.6 or later) The original file is also updated with a different icon to indicate it
failed and needed to be replayed. The file details of the original file contains a link
to the replayed file.

If only a single file was selected for replay, it is replayed when you click Replay.

If multiple files were selected for replay, or if you chose Replay All, the files are
marked for replay and the actual replay occurs the next time the
FileGatewayReroute business process runs. By default, the FileGatewayReroute
business process runs every five minutes.

You can replay a route any number of times. When you replay a route, the
reviewed box is automatically checked. Right-click and select Mark as Not
Reviewed to remove the check.

Restriction: If an EBICS transaction is replayed, the replayed activity is not noted
as being an EBICS transaction, because the EBICS translation activity does not take
place in the replay.

Redelivering a Processed File (2.2.0 - 2.2.4.2)
Redeliver a successful or a failed route to have the processed file delivered again.

About this task

Only files that have had a previous delivery attempt, successful or failed, can be
redelivered.

Procedure
1. From the Search page, enter criteria for the file to redeliver.
2. Click Find to initiate the search.

Note: Once activity is purged, it is no longer available in the system and will
not be found in a search that matches the criteria for it. You cannot redeliver
messages that have been purged.

3. Select the file, select the Route tab, and select the route.
4. On the Delivery tab, right-click on the delivery and select Redeliver this

Arrived File.
5. You can add a comment about the redelivery. Up to 255 characters are allowed

for the comment. The selected file is redelivered. Information about the
redelivery is added to the delivery details of the original delivery. You can
redeliver a route any number of times.

Note: Redeliveries create additional events for the original delivery, and do not
display as separate routes in the search results page.
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Redelivering processed files (V2.2.5 or higher)
Redeliver successful or failed routes to have one or more processed files delivered
again. The route processing is not repeated, the files are redelivered according to
previous processing. You can select files to redeliver, or redeliver all the files in the
list.

About this task

Restriction: Requires Sterling File Gateway Version 2.2.5 or later.

Only files that have had a previous delivery attempt, successful or failed, can be
redelivered.

To perform redelivery:

Procedure
1. Use either Basic Search or Advanced Search. From the Search Criteria tab, enter

the criteria for the file or files you want to redeliver.
2. Click Find to initiate the search.

Remember: After activity is purged, it is no longer available in the system and
are not found in a search that matches the criteria for it. You cannot redeliver
messages that are purged.

3. To redeliver all files matching the search criteria:
a. Click Redeliver All.
b. In the Redeliver Arrived File pop-up, you can add a comment about the

redeliver. Up to 255 characters are allowed.
c. In the Redeliver Arrived File pop-up, click Redeliver.

All files matching the search criteria, not just the ones displayed or selected, are
redelivered. Information about the redelivery is added to the delivery details of
the original delivery. You can redeliver a route any number of times.
Skip the remaining steps.

4. To redeliver only selected files, on the Arrived File tab, select one or more files
to redeliver.
v To select a file, click the check box in the first column to display a check

mark.
v To select all files, click the Header check box at the top of the column. All

selected files display a check mark in the first column.
The Header check box displays one of the following values depending on file
selections:

Checked
All the files are selected

Unchecked
No files are selected

Filled Some, but not all, of the files are selected
If only one file is selected, the Arrived File Events is displayed and Route and
Delivery tabs are available.

5. Click Redeliver. In the Redeliver Arrived File pop-up:
a. You can add a comment about the replay. Up to 255 characters are allowed.
b. Click Redeliver.
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Results

The selected files are redelivered. If only a single file was selected for redelivery, it
is redelivered when you click Redeliver. If multiple files were selected for
redelivery, or if you chose Redeliver All, the files are marked for redelivery and
the actual redelivery occurs the next time the FileGatewayReroute business process
runs. By default, the FileGatewayReroute business process runs every five minutes.

Information about the redelivery is added to the delivery details of the original
delivery. You can redeliver a route any number of times. Redeliveries create
additional events for the original delivery, and do not display as separate routes in
the search results page.

When you redeliver a route, the reviewed box is automatically checked. Right-click
and select Mark as Not Reviewed to remove the check.

Restriction: If an EBICS transaction is redelivered, the replayed activity will not be
noted as being an EBICS transaction, because the EBICS translation activity does
not take place in the redelivery.

Troubleshooting and resolving problems

Troubleshooting and resolving problems
Monitor the file activity routinely to check for failed transfers.

About this task

To resolve problems with file transfers:

Procedure
1. From the main menu, select Tools > Activity Snapshot, and check for New

Failures.
2. Click on the number in the New Failures column to see a list for the most

recent hour, day, or week displayed in the main window. Close the Activity
Snapshot window to view the list.

3. Click on an item in the returned list to see the details.
4. Verify that all business processes involved in processing and transferring the

files completed successfully.
5. Correct the conditions that caused the failure. For example, if there was an

FTP failure due to an incorrect password, update the Partner's FTP
configuration with the correct password.

6. To replay the failed transfer, right-click in the row of the arrived file and select
Replay this Arrived File.

7. Mark the activity as Reviewed to move it to the Reviewed Failures list.
Right-click and select Mark as reviewed, or click in the checkbox in the
Reviewed column. You can remove the check mark by clicking again, or by
right-clicking and selecting Mark as not reviewed. This field is useful for
Operators to track their monitoring of file activity and resolving problems.

8. Check for files in Routing State for extended periods of time, in cases that do
not show in New Failures or in Successfully Routed. Below the Activity
Snapshot, click the Total in-flight link.

9. Close the Activity Snapshot.
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10. Review the list for any files that may have stalled. Click in a row to view the
related events.

11. If there is a halted or failed business process, manually restart the business
process to resume the transfer.

Troubleshooting and resolving pending transfers after a
system or node failure

About this task

In a failover scenario, some producer messages may not get deleted from the
producer mailbox. To resolve this situation:

Procedure
1. Determine whether the message got routed. Select Tools > B2B Console >

Deployment > Mailboxes > Messages to search for files in the mailbox and
locate the message Id.

2. Use Advanced Search in Sterling File Gateway to find the message Id.
3. If you find a result, it should be failed. Replay the arrived file. This resolves the

issue without producer partner involvement.
4. If you did not find a result, contact the producer partner and have them

rename the file.
a. The producer logs in to their producer mailbox and notes the name of the

message. It must be the same user that added the file for Sterling File
Gateway to detect the route.

b. The producer navigates to the mailbox directory that contains the message
using the protocol originally used, such as FTP or SFTP.

c. The producer renames the message using the exact same name. The rename
command may have different names for different protocols and clients. For
example, in FTP and SFTP command line it is “rename filename filename”.

d. If Allow Duplicates=false, then the producer partner can re-put the file
which will overwrite the one that did not get routed.

Troubleshooting and resolving incomplete file transfers
If the business process responsible for a route fails or pauses due to a system
failure, arrived files may not transfer completely.

If the consumer can receive the same file again without causing problems, replay
the arrived file. Mark the arrived file as reviewed and enter comments with the
reason for the replay.

If the consumer cannot manage receiving a duplicate file, determine whether an
arrived file was already delivered before performing the replay. See Confirm File
Delivery.

Confirming file delivery
About this task

To confirm delivery of a file that may have been affected by a system failure, you
can call the consumer to verify that they received it.

Or, you can perform the following procedure:
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Procedure
1. On the Activity page, click on the Arrived File. The Route and Delivery tabs

should display.
a. If no Delivery tab or there are no deliveries under the Delivery tab,

deliveries were not attempted. Replay the Arrived File.
b. If there is a Delivery tab, there may have been delivery attempts. Continue

with Step 2.
2. For each delivery, look for the following event codes:

Code Name Event Description

FG_0201 BusinessProcessStarting The business process was started.
The event contains a link to the
workflow ID. In the case of
FileGatewaySendMessage, this
workflow ID is not the one that was
started and instead you should look
at FG_0203.

For FileGatewaySendMessage, look
for the FG/Protocol attribute. If
there is one, it provides the protocol.
If there is no Protocol attribute, the
transfer is a mailbox-only delivery.
Use this value to look for mailbox or
protocol deliveries in the
instructions below.

FG_0202 BusinessProcessCompleted Successful completion of the
business process. This means the
delivery was also successful, because
the process completed without
failures.

FG_0203 SendMessageBusinessProcessStarted The Send Message process was
started. This is unique because it is
asynchronous to the route. The
workflow ID link in this event is the
correct process.

FG_0250 BusinessProcessFailed The business process failed. You will
not see FG_0250 on a successful
process. Click through to the
workflow ID on this event to view
details about what happened.

FG_0701 DeliveryMailboxMessage The Mailbox Message was delivered
successfully.

3. If all events exist, the delivery to protocol and mailbox succeeded. If some
events are missing, the transfer may not have succeeded. Continue with step 4.

4. Verify mailbox delivery by checking the results of the MailboxAddService in
the FileGatewaySendMessage business process. A link to the
FileGatewaySendMessage business process is in the event text for FG_0202 and
FG_0203 under the Delivery tab. Click on the workflow ID link to go to the
business process. Based on the events listed, perform the following actions:
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Problem Solution

Only FG_0201 event exists Click the workflow ID link for FG_0201 to
go to the parent business process. Find the
correct subprocess under the
FileGatewayDeliveryService. If you only
have one delivery there will only be one
there.

If that service did not run, no mailbox or
protocol delivery occurred for that route.

If you find some subprocesses, click each
one to determine if it is the one you are
interested in. Compare the
DestinationMessageName in Process Data to
the delivery that failed to find the matching
process.

There are no FG_02xx events It is possible the SendMessage process was
not started, or there was data loss on the
events. To verify, click the workflow ID link
for FG_0425 under the Arrived File to go to
the parent business process. Find the correct
subprocess, if it exists. Use the table in Step
2 to find the correct subprocess. If no
subprocesses were started, the delivery did
not occur Continue to Step 5.

5. When you are viewing the correct FileGatewaySendMessage subprocess, look
for the MailboxAddService. If there is no MailboxAddService, the mailbox
delivery did not occur. If there is a MailboxAddService, check if it failed or
succeeded. Perform the following actions:

Mailbox Delivery Action

Succeeded for all deliveries Mark items as Reviewed.

Succeeded for no deliveries Replay Arrived Files, and mark as
Reviewed.

Succeeded for some deliveries Redeliver only the Failed deliveries, and
mark as Reviewed.

6. Check for protocol delivery. Find the link to the FileGatewaySendMessage
business process. A link to the FileGatewaySendMessage business process is in
the event text for FG_0202 and FG_0203 under the Delivery tab. Click on the
workflow ID link to go to the business process. Protocol delivery is performed
by a business process inside the FileGatewaySendMessage business process.
There is no specific service that you can check. With custom protocols, there
could be several services responsible for protocol delivery. In general, look for
the Invoke Subprocess Service and the next services will be protocol specific.
For FTP and SFTP protocols, look for services like FTPPut or SFTPPut. Follow
the flow and determine if the protocol delivery reached and completed the
service responsible for the actual delivery.

7. Check all the deliveries for the Arrived File against the following table. If they
all have Yes for “Replay/Redeliver” then Replay the Arrived File. If some are
Yes and some are No, then only redeliver the ones that have Yes and do not
Replay the Arrived File (or risk duplicate deliveries.)
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Protocol Mailbox Replay/Redeliver Action

Succeeded Succeeded No Delivery succeeded.
Do not replay or
redeliver.

Failed Succeeded Yes Although the file
succeeded to the
mailbox, replay or
redeliver so that it
also succeeds to the
protocol.

Succeeded Failed No Because the protocol
succeeded, do not
replay or redeliver
because it will cause
a duplicate delivery.
Ignore that the
mailbox failed.

Failed Failed Yes Replay or Redeliver

Troubleshooting and resolving a transport error
About this task

To resolve an error message of
Transport Error-HTTP Code:12029 for URL:./smartclientRPC.do

or similar:

Procedure
1. Close the current browser session and relaunch Sterling File Gateway in a new

browser session.
2. Log in to Sterling File Gateway
3. If the problem recurs, restart Sterling File Gateway at the server.

Troubleshooting and resolving blank arrived files
If an arrived file is blank, with no original file name or producer name, a system
failure may have caused the Sterling File Gateway router to be unable to process
the incoming message. There are several known situations that cause this:
v When a protocol client that uploads files to Sterling File Gateway performs

renaming of files upon transfer.
– Why this happens - the original file is deleted and renamed to a file with a

new name. If Sterling File Gateway tries to route the file with the original
name that was deleted, a failed blank arrived file is created. This happens
because the file got deleted before information like producer, original file
name and so forth are retrieved.

– What to do - click on the blank arrived file. In the details, locate the message
Id. Go to Tools > B2B Console > Correlation Search and enter the message
Id and click Find. In the results, locate the file name and mailbox path to
determine the producer. Contact the producer to confirm that their client that
uploads files is set to rename files upon transfer. Ensure that the file with the
new name is routed correctly.

v When a file is sent and immediately sent again, overwriting the first.
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– Why this happens - Allow duplicates=false in the Mailbox configuration. The
second file overwrites and deletes the first file. If this happens before Sterling
File Gateway reads the data about this file, then you have a blank route.

– What to do - this is harmless if both files contain the same data because the
second file is routed correctly. If multiple files with the same name and
different data are to be sent to the system, configure the system so these files
go to different mailboxes, or set Allow duplicates=true.

v When a system configured with a redundant Oracle RAC has a node failure.
– Why this happens - the arrived file temporarily cannot see the message

because of the failure and creates a blank arrived file to show that something
was supposed to happen, and then immediately fails the arrived file.

– What to do - replay the arrived file to get it to reroute. If this does not work,
the message was deleted before the replay. Investigate the database, the logs,
and the Activity list to find which message did not get added or got deleted
prematurely. Determine the producer and ask them to re-send the file.

v Both AFT and Sterling File Gateway are enabled at the same time.
– Why this happens - no AFT Routing Rules should be active after Sterling File

Gateway is installed.
– What to do - when Sterling File Gateway is installed, AFT is disabled. Do not

re-enable AFT Routing Rules.

Troubleshooting and resolving failed routes for renamed files
If Sterling File Gateway tries to route a file that has been deleted from the mailbox,
it results in a failed route. In the Arrived File list, click on the failed route to view
the Arrived File Events details. The following event message is listed:
FG-0450 ERROR: Producer Mailbox Message Does Not Exist.

Click on the dataflow link in the details.

This can happen when a protocol client that uploads files to Sterling File Gateway
performs renaming of files upon transfer.

System Administrators can specify the temporary file name pattern in the
ignoreFilenamex parameter as a regex expression in filegateway.properties. This
causes the specified patterns to be listed in the Arrived File list as Ignored.
Multiple file name patterns can be specified.
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Notices

This information was developed for products and services offered in the US. This
material might be available from IBM in other languages. However, you may be
required to own a copy of the product or product version in that language in order
to access it.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive, MD-NC119
Armonk, NY 10504-1785
US

For license inquiries regarding double-byte character set (DBCS) information,
contact the IBM Intellectual Property Department in your country or send
inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan Ltd.
19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some jurisdictions do not allow disclaimer of
express or implied warranties in certain transactions, therefore, this statement may
not apply to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM websites are provided for
convenience only and do not in any manner serve as an endorsement of those
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websites. The materials at those websites are not part of the materials for this IBM
product and use of those websites is at your own risk.

IBM may use or distribute any of the information you provide in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Director of Licensing
IBM Corporation
North Castle Drive, MD-NC119
Armonk, NY 10504-1785
US

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

The performance data and client examples cited are presented for illustrative
purposes only. Actual performance results may vary depending on specific
configurations and operating conditions.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBMproducts.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

Statements regarding IBM's future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

All IBM prices shown are IBM's suggested retail prices, are current and are subject
to change without notice. Dealer prices may vary.

This information is for planning purposes only. The information herein is subject to
change before the products described become available.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to actual people or business enterprises is entirely
coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
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IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
platform for which the sample programs are written. These examples have not
been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs. The sample
programs are provided "AS IS", without warranty of any kind. IBM shall not be
liable for any damages arising out of your use of the sample programs.

Each copy or any portion of these sample programs or any derivative work must
include a copyright notice as shown in the next column.

© 2015.
Portions of this code are derived from IBM Corp. Sample Programs.
© Copyright IBM Corp. 2015.

Trademarks
IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of
International Business Machines Corp., registered in many jurisdictions worldwide.
Other product and service names might be trademarks of IBM or other companies.
A current list of IBM trademarks is available on the web at "Copyright and
trademark information" at www.ibm.com/legal/copytrade.shtml.

Adobe, the Adobe logo, PostScript, and the PostScript logo are either registered
trademarks or trademarks of Adobe Systems Incorporated in the United States,
and/or other countries.

IT Infrastructure Library is a registered trademark of the Central Computer and
Telecommunications Agency which is now part of the Office of Government
Commerce.

Intel, Intel logo, Intel Inside, Intel Inside logo, Intel Centrino, Intel Centrino logo,
Celeron, Intel Xeon, Intel SpeedStep, Itanium, and Pentium are trademarks or
registered trademarks of Intel Corporation or its subsidiaries in the United States
and other countries.

Linux is a registered trademark of Linus Torvalds in the United States, other
countries, or both.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of
Microsoft Corporation in the United States, other countries, or both.

ITIL is a registered trademark, and a registered community trademark of the Office
of Government Commerce, and is registered in the U.S. Patent and Trademark
Office.

UNIX is a registered trademark of The Open Group in the United States and other
countries.

Java™ and all Java-based trademarks and logos are trademarks or registered
trademarks of Oracle and/or its affiliates.

Cell Broadband Engine is a trademark of Sony Computer Entertainment, Inc. in the
United States, other countries, or both and is used under license therefrom.
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Linear Tape-Open, LTO, the LTO Logo, Ultrium and the Ultrium Logo are
trademarks of HP, IBM Corp. and Quantum in the U.S. and other countries.

Connect Control Center®, Connect:Direct®, Connect:Enterprise®, Gentran®,
Gentran®:Basic®, Gentran:Control®, Gentran:Director®, Gentran:Plus®,
Gentran:Realtime®, Gentran:Server®, Gentran:Viewpoint®, Sterling Commerce™,
Sterling Information Broker®, and Sterling Integrator® are trademarks or registered
trademarks of Sterling Commerce®, Inc., an IBM Company.

Other company, product, and service names may be trademarks or service marks
of others.

Terms and conditions for product documentation
Permissions for the use of these publications are granted subject to the following
terms and conditions.

Applicability

These terms and conditions are in addition to any terms of use for the IBM
website.

Personal use

You may reproduce these publications for your personal, noncommercial use
provided that all proprietary notices are preserved. You may not distribute, display
or make derivative work of these publications, or any portion thereof, without the
express consent of IBM.

Commercial use

You may reproduce, distribute and display these publications solely within your
enterprise provided that all proprietary notices are preserved. You may not make
derivative works of these publications, or reproduce, distribute or display these
publications or any portion thereof outside your enterprise, without the express
consent of IBM.

Rights

Except as expressly granted in this permission, no other permissions, licenses or
rights are granted, either express or implied, to the publications or any
information, data, software or other intellectual property contained therein.

IBM reserves the right to withdraw the permissions granted herein whenever, in its
discretion, the use of the publications is detrimental to its interest or, as
determined by IBM, the above instructions are not being properly followed.

You may not download, export or re-export this information except in full
compliance with all applicable laws and regulations, including all United States
export laws and regulations.

IBM MAKES NO GUARANTEE ABOUT THE CONTENT OF THESE
PUBLICATIONS. THE PUBLICATIONS ARE PROVIDED "AS-IS" AND WITHOUT
WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING
BUT NOT LIMITED TO IMPLIED WARRANTIES OF MERCHANTABILITY,
NON-INFRINGEMENT, AND FITNESS FOR A PARTICULAR PURPOSE.
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